September 2021

Welcome Current & New PURA News Readers!

The PURA newsletter, published 10 times a year, regularly features articles on retiree benefits, Purdue news, upcoming opportunities to hear
interesting speakers with other retirees, health topics, humor, Indiana travel, and PURA business.

We hope you'll find this publication informative and entertaining, but if you're not interested you may, of course, opt out. [insert UDO "opt out
button" here, Kate]

We welcome your comments and suggestions (send to: pura@purdue.edu), and we invite you to join us at our virtual programs.
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— Sept. 9 PURA Kickoff Meeting

As Purdue begins its Fall 2021 semester we are looking forward to the annual PURA Kick-
off program for our retirees on September 9th.

We are excited to have you join other Purdue Retirees virtually, to hear Dr. Jay Akridge,
Provost and Executive Vice President for Academic Affairs and Diversity, present ‘Next
Moves for Purdue University’.

The annual Betty Nelson Award recipient will be announced and recognized, and in addi-

tion, a slide presentation of upcoming monthly meeting topics will be included, as well as
announcements of other points of interest.

Please join us for this enlightening program by clicking the link below at 12:15 p.m. ET for the pre-program opening.
[As noted in the email you already received, this is a different link than our normal monthly meetings.]

https://vimeo.com/584902422/9a48e84542

Boiler Up! Hammer down!
@ ®
Bill’s Bulletin:

When I went to work at the Day Care, the students would address the adult staff by their
first name preceded by Ms., Miss, or Mr. Of course I was “Mister Bill”, a popular cartoon
character. When I approached the classroom they would shout out in a loud falsetto voice,
“Here comes Mister Bill”. It was a fun name and easy to remember. They were always glad
to see me because I always brought something good to eat.

Flu shots for retirees will be offered on Friday, October 15, 22, and 29. Friday, October 15
and 22 will be from 8am to 2pm. Friday, October 29 will be from 1pm to 6pm. All flu shots
will be given at the Purdue 2550 building (formerly the State Farm Insurance building at
2550 Northwestern Ave); access via Kent Avenue. Wellness screenings will also be availa-
ble. Additional information such as room numbers, parking, etc. will be announced when
available.

Be safe, be smart. The Delta strain is no joke. Get vaccinated and mask up indoors.

William Bennett, President
PURA

WANTED
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United Health Care Update: Emergency Room Services

Several media outlets reported that United Healthcare intended, effective July 1, 2021, to withhold payment for emer-
gency room services not determined to be emergencies. Hospitals, medical care providers and many social service or-
ganizations made their concerns known to United Healthcare.

Since United Healthcare is the insurance provider for PURA’s PURCare and Medicare Advantage plans, PURA like-
wise was concerned when we learned of United Healthcare's intentions. The Benefits Committee contacted United
Healthcare to make them aware of our concerns.

We are pleased to report United Healthcare's decision to delay implementation of their new Emergency Room policy, at
least, until the end of the COVID pandemic. United Healthcare also confirmed that the proposed practice will not be ap-
plicable to PURA’s PURCare and Medicare Supplement plans.

Utilization data provided to us by United Healthcare shows that PURA members covered by PURCare have over the
years been careful to use the Emergency Room for emergency situations. We hope that will continue, as it has a positive
impact on our premiums. Likewise, if you are facing a health situation of an emergency nature, do not delay getting to
the Emergency Room for treatment.
@ L

New and Improved “Organizing My Affairs” Planning Document:
Now Available

Several years ago, the Benefits Committee created and published on the PURA website a document titled “Organizing
My Affairs.” This is a helpful guide to assist each of us in communicating to our loved ones how we would like our af-
fairs handled after our passing. Over the years, the technology grinches became embedded in the document making it
difficult to use.

A new and improved “Organizing My Affairs” is now available for download from the PURA website. Special thanks to
Ken Scheeringa of the PURA Media Communications Committee for his time and efforts in upgrading the document
into a user friendly and efficient format.

The following instructions have been prepared to guide you through the download process. We encourage you to follow
the guide, download “Organizing My Affairs” to your computer and complete it. You will be glad you did! Your loved
ones will be glad you did!

Steps to complete the “Organizing My Affairs” (OMA) document
—Download the blank OMA document from the PURA website to your local computer.

Adobe Acrobat Reader must be used to complete the document. If you do not have Reader it is a free download from
get.adobe.com/reader. Select the free version titled Adobe Acrobat Reader DC. Click the blue download button, then
follow the instructions to complete the install process. Decline options to install additional apps if they are offered. If
asked to accept Reader as your default PDF app, you should also decline this option. Do not use other apps beside Read-
er, such as inside of web browsers, to complete the OMA document. They will not work.

Start up Reader and navigate its menus in this sequence: Edit > Preferences > Javascript then click on the Enable Acro-
bat Javascript checkbox. This only needs to be done once on first use.

Begin filling in the OMA document.

—Items to Note during data entry

Date format

The date format dd-mmm-yyyy (e.g., 24-May-2021) was chosen for consistency throughout the document. If a different
format is entered a popup hint will remind you of the desired format after the first incorrect attempt in that field or the

app will automatically fix the format for you. A few date fields are not format checked at all, such as when a date range
is required or is non-specific.
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(New “Organizing Your Affairs,” continued)

Field validation

Data entries such as birth dates, phone numbers, monetary amounts, etc., are format specific. The app attempts to vali-
date the format is correct, but not the value itself. For example, phone numbers such as (123)-456-7890 will pass valida-
tion but is not necessarily a working phone number.

Field Overflow

What happens when a data entry is longer than the field space provided? As an entry is typed, its length is monitored by
the app. As soon as a field overflows, a popup box will alert the user the field is full. Click the OK button in the popup
box. If a “+” symbol appears at the end of the answer field, also click on the symbol. Now position your cursor after the
last character shown in your answer and resume typing right where you left off. Only part of your answer may show in
the answer field as it wraps one or more times. When you have completed your answer and moved to another field, your
complete answer has been saved regardless of what portion is shown in the answer field.

Viewing/Printing Field Overflows

Now, later, or when you have finished the OMA document — page down to the final page of the OMA document. Click
the POST button on that page. All overflow answers within the OMA document will be titled and listed in their entirety
on this final page. Any text on this page can be rearranged by the user to improve its appearance. This full page will also
be included when the OMA document is saved or printed.

Save or Print the OMA document
Use the app menu File > Save As and/or File > Print commands to save and print your OMA document for future refer-
ence and to make changes as needed.

PERF Retirees Lose 13th Check

Some feel thirteen (13) is an unlucky number, but the PERF 13th check has been a positive for Purdue and other state
employees, including teachers and firefighters. Yet Indiana State Legislatures have voted to eliminate this benefit for
retirees, those who have dedicated their careers to serving the State of Indiana.

In February, 2021, a bill presented by Representative Mike Karickhoff called for the continuation of the 13th check, in-
cluding a $50 increase, stating a “fair dispensation for the valuable work by state employees, past and present,” which
was then approved by the State House of Representatives. However, a decision to eliminate the 13th check, did not make
it through the State Senate. Instead, the Senate chose a replacement of a 1% Cost of Living Adjustment, causing a severe
loss to most Purdue PEREF retirees.

Senator Ryan Mishler, Chairman of the Senate Committee of Appropriations, made the following statement on July 14,
2021. “Due to the robust state of the economy, Indiana is able to end the state fiscal year with strong reserve levels,
make an additional investment in our pension liabilities and provide a taxpayer refund.” Which makes the decision by
the Senate to eliminate the 13th check even more questionable.

Senator Ron Alting and Senator Shelli Yoder have both indicated support for the 13th check. Senator Alting has long
been a supporter of the Indiana Teachers Association and Purdue and lobbied hard for us. He said he “understands the
need of the 13th check and how retirees depend on it.” Senator Yoder stated, “the decision to eliminate the 13th check
and implement the COLA 1% was a better option for those who are younger in their careers, while the 13th check would
have been a better outcome for those already retired.”

Many of these younger employees are more than likely to leave their state jobs for better benefits and pay after a shorter
period of time than present Purdue retirees. The 13th check was a perk given to state retirees, and employees, at the end
of a fiscal year when the pension fund performed better than expected. We need to question why this elimination was
made.

Both Senators Alting and Yoder support working to reinstate the 13th check. Along with their support, and working with
the Indiana Retired Teachers Association, Retired Public Employees Association, and other state organizations, we need
to contact our state legislators and let them know we are not okay with their decision. If we remain silent, they will be-
lieve we are accepting of this devastating loss, which is already in effect for 2021. In order to bring the 13th check back
for 2022, please contact your state legislators at “iga.in.gov”. Please include your years of service, and position. Let our
state legislators know how the 13th check personally affects you and your family. Let our state legislatures know we are
still valuable state retirees.
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Still Space Available to Tour New Loeb Stadium at Columbian Park

As announced in last month’s issue, the Campus and Community Activities Committee arranged a discussion, Q&A,
and tour of the new Loeb Stadium at Columbian Park in Lafayette on September 23. There is still space available if
you’d like to attend!

Registration
You must be registered to attend. Contact Hannah Austerman pura@purdue.edu to register. (The tour can accommodate
up to 30 individuals, and there are still 10 openings left.) The deadline to register is September 17, 2021.

Description

Jon Miner, Director of Operations, Lafayette Parks and Recreation will lead the activity for Purdue Retirees who choose
to attend. Jon will be using the park’s five-year strategic plan as his guide in explaining the steps that went into the plan-
ning, funding, and management of the changes that have taken place in the park. His presentation will not only focus on
the removal, rebuilding, and planned future use of the state-of-the-art stadium but will also include key improvements
like the return of the park carousel, and the restoration of the park lagoon and island. Participants are asked to bring their
questions to ensure a lively discussion.

Assembly
Sept. 23, 1:15 p.m. to 1:30 p.m. ET. Plan to arrive early. Participants will assemble at the main entrance on Wallace St.,
Lafayette. This entrance is covered and is directly across the street from the blue awning of the Original Frozen Custard.

Discussion/Q&A

Promptly at 1:30 p.m. ET, participants will enter the stadium and be guided to a designated seating area. Jon’s discus-
sion will be approximately 30 minutes with ample time for questions and answers. Retirees are asked to come prepared
to ask questions.

Tour

At approximately 2:15 p.m. ET, Jon will lead the group on a behind the scenes comprehensive tour of Loeb Stadium. In
addition, weather permitting, lucky participants may be invited to walk the bases or throw out an imaginary pitch! Or, sit
in the mayor’s box!

Treats

To relax and unwind at the conclusion of the stadium tour at 3:00 p.m. ET, everyone is invited across the street to the
Original Frozen Custard for a treat. (Participants are responsible for paying for their own purchases.) Participants may
also choose to continue exploring Columbian Park on their own if they so choose.

Parking
Ample parking is available at the newly paved lot at the corner of Main St. and Kossuth St. This parking lot is a one
block walk from the main stadium entrance.

Walking
There will be extensive walking with multiple flights of stairs to ascend and descend on the tour. Please plan according-
ly. (Those with mobility issues may choose to attend the discussion and Q&A and skip the tour.)

Still Space Available to Tour West Lafayette Wellness Center Octo-
ig| ber 1

M As announced in last month’s newsletter, the Campus and Community Activities Com-
mittee invites PURA members to tour the new West Lafayette Wellness Center on Fri-
day, October 1, at 1:00 p.m. ET, and there’s still space available to join in!

The 73,000 square foot facility is located at 1101 Kalberer Road, in Cumberland Park in
West Lafayette. They opened their doors to the public in January 2021.

The facility features community meeting rooms, three basketball courts, a walking track, fitness studios, workout areas,
an indoor playground, and a zero-depth entrance pool.
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(Tour of W.L. Wellness Center—continued)

Organized by Director Kevin Noe and his staff, the tour will showcase the amenities of the new center and include a
Q&A session.

The group will be divided into smaller groups for the tour, so attendees should plan to arrive a few minutes before the
start time to get organized. The tour will last about an hour. There is plenty of parking on-site. The tour is limited to a
total of 40 participants. If you are interested in attending, please contact Hannah Austerman (pura@purdue.edu) no
later than Friday, September 24, 2021.

ey

1917: A group of women listened to a dynamic motivational speaker who said there was a great need to help the victims
of war-torn France. America was not involved at that time. Surprisingly, 18 young women answered the call. They went
for many reasons, with one thing in common: they were all graduates of Smith College.

Confessions of a Book Addict
By Jo Thomas

The ladies arrived in France looking splendid in their uniforms of grey plaid with peplums and straw sailor hats. The uni-
forms were about the only smart things. The plan to furnish cows, goats and chickens met problems at every turn. Of par-
ticular worry were the chickens who were not laying eggs. The arrival of the agriculture agent explained that they were
roosters. The non-laying chickens made very good stew.

The Band of Sisters is a novel, but the facts of their service is all true. Author Lauren Willig happened upon a memoir
by Ruth Gaines of the Smith College Relief Unit, “The Ladies of Grecourt.” Grecourt was in the Somme close to the
front line. Digging deeper, Smith College proved a treasure-trove of letters, diaries and newspaper reports. This story
needed to be published.

The three main characters were purely fictional. The rest were bits and pieces of actual women of the unit. All the inci-
dents are true. This is a fantastic book and tale.

As always [ am delighted to find a Purdue connection. Willig’s French language consultant was Professor Jessica Strum
of Purdue University.

Editor’s Note: We're sorry to note that this will be Jo’s last book review for PURA News, as she’s moving on
to other things. We hope you 've enjoyed her diverse book recommendations, and thank her so much for her
terrific articles!!

The August 2021 Commencement returned

to Elliott Hall of Music. Here, degree candi-
dates traverse the plaza in front of Hovde
Hall on the way to receiving their degrees.

(Photo courtesy of University News Service.)
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PURA Tech Bytes
By Scott Ksander

Windows 11 Is Coming

Microsoft has announced that Windows 11 will be available before the end of 2021. “With
Windows 11 we have renewed sense of Windows’ role in the world,” Microsoft CEO Satya
Nadella said while announcing the new software. Windows 11 marks the first major update to
Microsoft’s operating system since Windows 10 launched back in 2015. Windows 11 may be
a big update for Microsoft powered systems, but the company says it will be a free update for
existing users of Windows 10. At the same time, Microsoft quietly announced that it would
end support for Windows 10 in 2025.

Windows 11 features a streamlined new design, with pastel-like colors and rounded corners,
and overall a more Mac-like look. The Windows Start menu has moved from the bottom left of the screen to the middle,
with app icons arranged in the center next to it. Microsoft Teams will also be built directly into Windows 10, becoming
a more Facetime-like chat app. The biggest changes will be under the hood. Microsoft is expected to revamp internals
taking into account that people don’t just work in the office anymore, but also at home.

System requirements will change for Windows 11. The system is only run on 64-bit systems running TPM 2.0. TPM is
the Trusted Platform Module that has been standard for systems for approximately the last six years. Older hardware
may not be able to run Windows 11. Additionally, Windows 11 will require the user to have a network connection and a
Microsoft Account (MSA) to set up their system for the first time. This requirement is designed to address a more seam-
less installation experience and reduce customer confusion.

A slew of once-hyped Windows 10 features, including Cortana and Timeline, are among a handful of apps will vanish in
Windows 11. Internet Explorer will be completely replaced by the Microsoft Edge browser. 3D Viewer, OneNote for
Windows 10, Paint 3D, and Skype are a few of the apps going away.

Windows 11 will be expected by the holidays and may come installed on new systems purchased as a gift. Even though
the upgrade will be available this year, it is wise to not be the first person on your block to upgrade. A change of this
magnitude is likely to come with problems and confusion. Windows 11 updates will be the topic of future PURA Tech
Bytes.

Microsoft has also announced free trials on Windows 365 Cloud PC service. Basically, this lets you run a “remote desk-
top” on your system using a more powerful Windows system in the cloud. This means you can own a less expensive
system with a subscription to a more powerful resource in the cloud. The cost is based on the power of the cloud system
being used: starting systems may be about $24 per month. This capability could provide exactly the same system for
users who work both in the office and at home. Again, being the first on your block to try this may not be the best idea
for non-IT retirees but interesting things are coming that will have more capabilities and new features.
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Simple Ear Cleaning Tips
Chris Rearick, MSN, RN
Purdue Nursing Center for Family Health

Have you noticed a change in your hearing?

Hearing loss is common as we age. Hearing loss can be due to years of repeated noise exposure, a previous infection or
illness, taking a medicine, a genetic predisposition, or just cerumen build-up. Cerumen is a medical term for earwax!

Earwax production is good and normal. Wax protects our ears from bacteria, itching and small debris. We have tiny hair
follicles lining the ear canal and glands within the ear canal that produce the earwax. As wax is made, it lines the ear
canal. Earwax usually falls out on its own, but if not, it builds up. This sticky wax build-up can cause dizziness, ringing,
pain and infection in the ears. A build-up of earwax can block the tympanic membrane or eardrum and sound is unable
to reach the eardrum. When sound cannot reach the eardrum, you experience a conductive hearing loss. Eventually you
may notice your hearing has declined.

Earwax build-up is common and treatable. Some common reasons for earwax build-up are the use of hearing aids, a his-
tory of ear infections, just excessive wax production and using a Q-Tip. Sticking a Q-Tip in your ear can push the ear-
wax further into the canal and cause an obstruction. You may also rupture your eardrum with a Q-Tip. Do not stick
Q-Tips in the inner ear. If you are experiencing dizziness, pain or ear drainage then see your healthcare provider.

Here are some easy ear cleaning tips. Do not attempt to dig wax out of your ear.

—You may clean your canal by wrapping a damp washcloth around your finger. Wipe the outer canal of your ear
with the washcloth.

—Use an earwax softening solution such as mineral oil, sweet oil, olive oil or a wax softening solution such as
Debrox. You can purchase an ear cleaning kit at your local retailer for about $8.00. This kit comes with wax softening
drops and an ear bulb syringe. A Debrox Kit is a common one to our area. Tilt your head sideways and place 4-5 drops
into ear facing up being careful not to put applicator tip in ear. Keep drops in for several minutes and you may even put
a small cotton ball in the ear so oil can absorb. Repeat the same process to the other ear. Apply twice a day for 4 days.
You may then use some slightly warm water and a bulb syringe to flush ear. You may do this with your head leaning
over a sink. Softened wax should easily come out with the flushing.

—You can schedule an appointment with your healthcare provider. Most providers will clean your ears in the of-
fice. You may want to bring someone with you in case the cleaning causes dizziness.

—You can call me, Chris Rearick, at 496-0308 and schedule an ear evaluation appointment or ask questions. The
appointment is free. We can discuss options for you and review self- cleaning instructions.

I am able to flush your ears after you use an earwax softener for 4 days. Ear flushing is a $20.00 fee and we do not ac-

cept insurance. Keep in mind that flushing your ear with water may cause dizziness so you may want to have someone
with you.

If you would like to schedule a Wellness Screening please call Chris at 765-496-0308 or email at crearick@purdue.edu

to pick a day and time best for you. Feel free to contact Chris with any questions or concerns you may have.
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Road Trip! Indiana’s Spring Mill State Park

By Connie Bilyeu

Ah, early June at Spring Mill State Park (south of Bloomington, near Mitchell, Indiana). Peace, quiet...oh, except for
those zillion cicadas, presumably the Brood X seventeen year guys.

I hadn’t been to Spring Mill since a spring break trip with my parents in 6th grade. (I am NOT telling how long ago
that was!) I found the neat stuff [ remembered still there—the classic limestone inn built by the Civilian Conservation
Corps between 1936-1938, and the “Pioneer Village” depicting life in the village in 1863—though the Twin Caves
boat tour was temporarily closed due to COVID concerns, and the village interpreters are only there periodically now,
which was disappointing. The gristmill wasn’t running either while we were there, but I did get to buy some stone-
ground corn meal.

The area around Spring Mill was settled in the early 1800’s, and by 1817 the water-powered mill was built and village
established, supporting both grist and sawmill operations. The village was the center of commerce in the area through
the 1850’s, when as many as 20 families lived there, but declined in the next few decades. The steep slopes and narrow
valley in which Spring Mill was located prevented railroad access. Steam-powered engines meant farmers could grind
their grain at home and avoid transporting grain to the mill. Steam engines were reliable and not subject to the outages
caused by variable water levels in the creek that powered the mill. The Civil War broke out, leaving the village with
fewer men and affecting trade routes on the waterways to which Spring Mill was connected. By 1863, the timeframe
captured in the historic village, the population had declined dramatically, Spring Mill Post Office had closed 4 years
earlier and relocated to Mitchell, and by 1892, the village was virtually abandoned.

Spring Mill State Park also hosts the Gus Grissom Memorial museum on the property, of interest to “mother of astro-
nauts” fans. It includes his space suit and Gemini III space capsule (on loan from the Smithsonian), and other NASA

and personal memorabilia. Grissom was a native of Mitchell, Indiana, which is why this site was selected. Admission
is free, and accessible from the main road before you encounter the gated entrance to the rest of the park.

The park offers lodging in the inn or campground, bike and boat rental, a boat launch, fishing (state license required),
hiking, picnic areas and a swimming pool, in addition to the historic village and Grissom museum. Generally, I found
Spring Mill is still a lovely place to stay, hike, and learn a little Indiana history.

VIRGIL 1. “GUS" GRISSOM

State Memorial

Astronaut & American Hero
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True Tales of an Entomologist
By Tom Turpin

Editor’s Note: This is the sixth installment of Tom Turpin’s colorful experiences, which
appear in his self-published Memoirs.

Salad With or Without Meat

Not long after I arrived at Purdue, I started doing a talk about entomophagy — the practice

of eating insects. The talk was all about the history of humans consuming insects and was
: presented with a demonstration of cooking and eating the six-legged creatures. I did the

talk often enough so that many of my friends at Purdue had seen the presentation or knew about it.

One day [ was having lunch in a cafeteria at Purdue’s Stone Hall. In those days the cafeteria offered salads sold on the
basis of weight, and you could purchase them with or without meat — at a higher cost for the addition of meat. So I load-
ed some leafy green material into a salad bowl, doused it with ample ranch dressing, purchased it and sat down at a table
with three other Purdue staff.

As I was eating my salad [ happened to uncover an armyworm that had somehow hitched a ride with the leafy green ma-
terial. I pointed the worm out to my friends who got a big kick out of the fact that of all the people who would find a
worm in their salad it would be me. One of my tablemates called the person in charge of the cafeteria to our table to
show him the worm in my salad.

The person in charge took one look and asked “Did you purchase the salad with or without meat?” I said “Without
meat.” He didn’t bat an eye and without a hint of irony in his voice he replied, “Get over there and weigh that salad
again because you should have paid for a salad with meat!”

[ ®
Notable September Historic Events

1620—September 16. The Mayflower ship departed from England, bound for America with 102 passengers and a small
crew. The ship weathered dangerous Atlantic storms and reached Provincetown, Massachusetts on November 21. (The
Pilgrims disembarked at Plymouth on December 26.)

1690—September 25. The first American newspaper was published. A single edition of Publick Occurrences Both For-
eign and Domestick appeared in Boston, Massachusetts. However, British authorities considered the newspaper offen-
sive and ordered its immediate suppression.

1776—September 9. The United States came into existence as the Continental Congress changed the name of the new
American nation from the United Colonies.

1783—September 3. The Treaty of Paris was signed by John Adams, Benjamin Franklin and John Jay, formally ending
the American Revolutionary War between Britain and the United States.

1908—September 17. The first fatality involving powered flight occurred as a biplane piloted by Orville Wright fell
from a height of 75 feet, killing Lt. Thomas E. Selfridge, his 26-year-old passenger. A crowd of nearly 2,000 spectators
at Fort Myer, Virginia, observed the crash of the plane which was being tested for possible military use. Wright himself
was seriously injured.

1973—September 20. The much-hyped "Battle of the Sexes" took place in the Houston Astrodome as tennis player and
women's rights activist, Billie Jean King, defeated self-styled male chauvinist Bobby Riggs in three straight sets. Riggs,
a retired tennis champion, had been critical of the quality of women's tennis.

1994—September 7. The U.S. Army closed its headquarters in Berlin, ending the American military presence in the once
-divided city after nearly half a century.

2001—September 11. The worst terrorist attack in U.S. history occurred as four large passenger jets were hijacked then
crashed, killing nearly 3,000 persons.
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Notable September Birthdays

The City of Lafayette’s namesake—Marie Joseph Paul Yves Roch Gilbert du Motier, Marquis de La Fayette—(1757-
1834), was a French aristocrat and military officer. He fought and led troops in the American Revolutionary War, in-
cluding leading the troops that held off Cornwallis’ forces at Yorktown, gaining fame and gratitude among the Ameri-
can people. At least 9 towns in the United States are named Lafayette after this hero, and many more public squares,
townships, towns, counties, and parishes carry other derivatives of his name, for example, Fayette and Fayetteville.

American folk legend Johnny Appleseed (1774-1845) was born in Leominster, Massachusetts (as John Chapman). For
40 years, he traveled through Ohio, Indiana and into Illinois, planting orchards. He was a friend to wild animals and was
regarded as a "great medicine man" by Native Americans.

Architect Louis Henry Sullivan (1856-1924). Influential architect of the Chicago
School, called the “father of skyscrapers”, and mentor to architect Frank Lloyd Wright.
The phrase “form follows function” is attributed to Sullivan. West Lafayette’s Purdue

| State Bank Building (now a Chase bank branch), at 210 W. State Street, is an example
of his work and was opened in 1914.

Outlaw Jesse James (1847-1882) was born in Centerville, Missouri. Following the American Civil War, Jesse and his
brother Frank formed a group of outlaws, robbing banks, trains, stagecoaches and stores. In 1882, after the governor of
Missouri offered a $10,000 reward for their capture dead or alive, a member of the gang shot 34-year-old Jesse in the
back of the head and claimed the reward.

Composer George Gershwin (1898-1937) was born in Brooklyn, New York. Along with his brother Ira, he created en-
during songs including “The Man I Love,” “Strike Up the Band,” “I Got Rhythm,” and the opera “Porgy and Bess.”

Boxing champ Rocky Marciano (1923-1969) was born in Brockton, Massachusetts (as Rocco Francis Marchegiano). He
fought Jersey Joe Walcott for the heavyweight title on September 23, 1952, and knocked him out. In 1956, he retired as
the only undefeated heavyweight champion. He died in a plane crash in 1969.

Puppeteer Jim Henson (1936-1990) was born in Greenville, Mississippi. He created the Muppets, including Kermit the

Frog, Miss Piggy, and Bert and Ernie, entertaining and educating generations of children via the daily TV show Sesame
Street.

Other Americans born in September, among many:

—U.S. President William Howard Taft;

—Musicians Gene Autry, Ray Charles, Patsy Cline, Gloria Estefan, Jose Feliciano, Faith Hill, Joan Jett, B.B. King,
Johnny Mathis, Otis Redding, Bruce Springsteen, Mel Torme and Conway Twitty;

—Journalists Charles Kuralt and Barbara Walters;

—Authors Truman Capote, James Fenimore Cooper, T. S. Elliott, William Faulkner, F. Scott Fitzgerald, Steven King,
John Knowles, Upton Sinclair;

—Sports figures Jim McKay, Roger Maris, Jesse Owens, Arnold Palmer, Phil Rizzuto, and Serena Williams;

—A host of actors and actresses, including: Anne Bancroft (The Miracle Worker), Jane Curtin and Lily Tomlin
(Saturday Night Live), Peter Falk (Columbo), Mitzi Gaynor (South Pacific), Mark Hamill (Star Wars), Mark Harmon
(NCIS), Tommy Lee Jones and Will Smith (Men in Black), Michael Keaton (Batman), Clayton Moore (The Lone Rang-
er), comedian Bob Newhart, Christopher Reeve (Superman), Mickey Rooney (Andy Hardy, Boys Town), Jack Warden
(character actor, dozens of movies and TV series), Jo Anne Worley and Henry Gibson (Laugh In), Fay Wray (King
Kong).
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About PURA News

The Purdue University Retirees Association newsletter is published for o
retirees of Purdue University, and prepared by the PURA Communicati
mittee.

Send suggestions or ideas for PURA or the newslette

Office of Retiree Affairs

2550 Northwestern Ave., Suite 110
West Lafayette, IN 47906
Telephone, via Purdue Be

Email: pura@purdue

2020-2021 PURA Co
Chair: Karen
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Zoom Connection Information for PURA Meetings

Note: Next monthly meeting that will use this link will be
held October 4, 2021.

The Zoom connection information for PURA monthly meetings is shown below. The link, Meeting ID, and password
will be the SAME for all normal monthly meetings.

Members who wish to join via phone call audio only will need the separate Passcode shown below. (The password/
passcode for that method is different from the normal “computer con-
nection” to Zoom.)

Join Zoom Meeting
https://zoom.us/j/97285398989?
pwd=MIB4UOFudEpIMFRoWm1GTkZzNmYrZz09

Meeting ID: 972 8539 8989
Passcode: BoilerUp

One tap mobile
+13126266799,,972853989894,,.,,,0#,,41051096# US (Chicago)
+19292056099,,972853989894,,.,,,0#,,41051096# US (New York)

Dial by your location
+1 312 626 6799 US (Chicago)
+1 929 205 6099 US (New York)
+1 301 715 8592 US (Germantown)
+1 346 248 7799 US (Houston)
+1 669 900 6833 US (San Jose)
+1 253 215 8782 US (Tacoma)
Meeting ID: 972 8539 8989
Passcode: 41051096
Find your local number: https://zoom.us/u/acvQQKVcnE
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